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1. COUNT functions 

The COUNT function counts the number of cells that contain numbers, and counts numbers within the list 

of arguments. Use the COUNT function to get the number of entries in a number field that is in a range or 

array of numbers. For example, you can enter the following formula to count the numbers in the range 

A1:A20: =COUNT(A1:A20). In this example, if five of the cells in the range contain numbers, the result is 5. 

Syntax 

COUNT(value1, [value2], ...) 

The COUNT function syntax has the following arguments: 

 value1    Required. The first item, cell reference, or range within which you want to count 

numbers. 

 value2, ...    Optional. Up to 255 additional items, cell references, or ranges within which 

you want to count numbers.  

Note: The arguments can contain or refer to a variety of different types of data, but only numbers 

are counted. 

Remarks 

 Arguments that are numbers, dates, or a text representation of numbers (for example, a 

number enclosed in quotation marks, such as "1") are counted. 

 Logical values and text representations of numbers that you type directly into the list of 

arguments are counted. 

 Arguments that are error values or text that cannot be translated into numbers are not 

counted. 

 If an argument is an array or reference, only numbers in that array or reference are counted. 

Empty cells, logical values, text, or error values in the array or reference are not counted.  

 If you want to count logical values, text, or error values, use the COUNTA function. 

 If you want to count only numbers that meet certain criteria, use the COUNTIF function or 

the COUNTIFS function. 

The COUNTA function counts the number of cells that are not empty in a range. 

Syntax 

COUNTA(value1, [value2], ...) 

The COUNTA function syntax has the following arguments: 

 value1    Required. The first argument representing the values that you want to count. 

 value2, ...    Optional. Additional arguments representing the values that you want to count, 

up to a maximum of 255 arguments. 

Remarks 



 The COUNTA function counts cells containing any type of information, including error 

values and empty text (""). For example, if the range contains a formula that returns an 

empty string, the COUNTA function counts that value. The COUNTA function does not 

count empty cells. 

 If you do not need to count logical values, text, or error values (in other words, if you want 

to count only cells that contain numbers), use the COUNT function. 

 If you want to count only cells that meet certain criteria, use the COUNTIF function or the 

COUNTIFS function. 

Use COUNTIF, one of the statistical functions, to count the number of cells that meet a criterion; 

for example, to count the number of times a particular city appears in a customer list.  

In its simplest form, COUNTIF says: 

 =COUNTIF(Where do you want to look?, What do you want to look for?) 

For example: 

 A B 

1 Data  Data  

2 apples 32 

3 oranges 54 

4 peaches 75 

5 apples 86 

=COUNTIF(A2:A5,"apples") Counts the number of cells with apples in cells A2 through 

A5. The result is 2. 

=COUNTIF(A2:A5,A4) Counts the number of cells with peaches (the value in A4) in 

cells A2 through A5. The result is 1. 

=COUNTIF(A2:A5,A2)+COUNTIF(A2:A5,A3) Counts the number of apples (the value in A2), and oranges 

(the value in A3) in cells A2 through A5. The result is 3. This 

formula uses COUNTIF twice to specify multiple criteria, one 

criteria per expression. You could also use the COUNTIFS 

function. 

=COUNTIF(B2:B5,">55") Counts the number of cells with a value greater than 55 in 

cells B2 through B5. The result is 2. 

=COUNTIF(B2:B5,"<>"&B4) Counts the number of cells with a value not equal to 75 in 

cells B2 through B5. The ampersand (&) merges the 

comparison operator for not equal to (<>) and the value in 

B4 to read =COUNTIF(B2:B5,"<>75"). The result is 3. 

=COUNTIF(B2:B5,">=32")-

COUNTIF(B2:B5,">85") 

Counts the number of cells with a value greater than (>) or 

equal to (=) 32 and less than (<) or equal to (=) 85 in cells B2 

through B5. The result is 3. 

 

https://support.office.com/en-us/article/countifs-function-dda3dc6e-f74e-4aee-88bc-aa8c2a866842


2. Text functions  

http://www.excel-easy.com/ 

Excel has many functions to offer when it comes to manipulating text strings. 

Join strings 

The CONCATENATE function in Excel is designed to join different pieces of text together or 

combine values from several cells into one cell. 

The syntax of Excel CONCATENATE is as follows: 

CONCATENATE(text1, [text2], …) 

Where text is a text string, cell reference or formula-driven value. 

Below you will find a few examples of using the CONCATENATE function in Excel. 

Note. In Excel 2016, Excel 2019, Excel Online and Excel Mobile, CONCATENATE is replaced with the CONCAT 

function, which has exactly the same syntax. Although the CONCATENATE function is kept for backward 

compatibility, it is recommended to use CONCAT instead because Microsoft does not give any promises 

that CONCATENATE will be available in future versions of Excel. 

Concatenating the values of several cells 

The simplest CONCATENATE formula to combine the values of cells A1 and B1 is as follows: 

=CONCATENATE(A1, B1) 

Please note that the values will be knit together without any delimiter, as in row 2 in the screenshot 

below. 

To separate the values with a space, enter " " in the second argument, as in row 3 in the screenshot 

below. 

=CONCATENATE(A1, " ", B1) 

 

To separate the concatenated values with other delimiters such as a comma, space or slash, please 

see Excel CONCATENATE formulas with special characters. 

Concatenating a text string and cell value 

There is no reason for the Excel CONCATENATE function to be limited to only joining cells' 

values. You can also use it to concatenate various text strings to make the result more meaningful. 

For example: 

https://www.ablebits.com/office-addins-blog/2015/07/15/excel-concatenate-strings-cells-columns/#concatenate-cells-space


=CONCATENATE(A1, " ", B1, " completed") 

The above formula informs the user that a certain project is completed, as in row 2 in the screenshot 

below. Please notice that we add a space before the word " completed" to separate the concatenated 

text strings. 

Naturally, you can add a text string in the beginning or in the middle of your Concatenate formula 

as well: 

=CONCATENATE("See ", A1, " ", B1) 

A space (" ") is added in between the combined values, so that the result displays as "Project 1" 

rather than "Project1". 

 

Concatenating a text string and a formula-calculated value 

To make the result returned by some formula more understandable for your users, you can 

concatenate it with a text string that explains what the value actually is. 

For example, you can use the following formula to return the current date: 

=CONCATENATE("Today is ",TEXT(TODAY(), "dd-mmm-yy")) 

 

Using CONCATENATE in Excel - things to remember 

To ensure that your CONCATENATE formulas always deliver the correct results, remember the 

following simple rules: 

 Excel CONCATENATE function requires at least one "text" argument to work. 
 In a single CONCATENATE formula, you can concatenate up to 255 strings, a total of 8,192 

characters. 
 The result of the CONCATENATE function is always a text string, even when all of the source values 

are numbers. 
 Excel CONCATENATE does not recognize arrays. Each cell reference must be listed separately. For 

example, you should write =CONCATENATE(A1, A2, A3) instead of =CONCATENATE(A1:A3). 
 If at least one of the CONCATENATE function's arguments is invalid, the formula returns a #VALUE! 

error. 

"&" operator to concatenate strings in Excel 

In Microsoft Excel, & operator is another way to concatenate cells. This method come in very 

handy in many scenarios because typing the ampersand sign (&) is much quicker than typing the 

word "concatenate" :) 



Similarly to the CONCATENATE function, you can use "&" in Excel to combine different text 

strings, cell values and results returned by other functions. 

Excel "&" formula examples 

To see the concatenation operator in action, let's re-write the CONCATENATE formulas discussed 

above: 

Concatenate the values in A1 and B1: 
=A1&B1 

Concatenate the values in A1 and B1 separated with a space: 
=A1&" "&B1 

Concatenate the values in A1, B1 and a text string: 
=A1 & B1 & " completed" 

Concatenate a string and the result of the TEXT / TODAY function: 
="Today is " & TEXT(TODAY(), "dd-mmm-yy") 

As demonstrated in the screenshot below, the CONCATENATE function and "&" operator return 

identical results: 

 

Excel "&" operator vs. CONCATENATE function 

Many users wonder which is a more efficient way to concatenate strings in Excel - 

CONCATENATE function or "&" operator. 

The only essential difference between CONCATENATE and "&" operator is the 255 strings limit 

of the Excel CONCATENATE function and no such limitations when using the ampersand. Other 

than that, there is no difference between these two concatenation methods, nor is there any speed 

difference between the CONCATENATE and "&" formulas. 

And since 255 is a really big number and in real-life tasks someone will hardly ever need to 

combine that many strings, the difference boils down to the comfort and ease of use. Some users 

find CONCATENATE formulas easier to read, I personally prefer using the "&" method. So, 

simply stick to the concatenation technique that you feel more comfortable with. 

 



 

Extract info  

Left 

To extract the leftmost characters from a string, use the LEFT function. 

 

Right 

To extract the rightmost characters from a string, use the RIGHT function. 

 

Mid 

To extract a substring, starting in the middle of a string, use the MID function. 

 

Note: started at position 5 (p) with length 3. 

Len 

To get the length of a string, use the LEN function. 

 

Note: space (position 8) included! 



Find 

To find the position of a substring in a string, use the FIND function. 

 

Note: string "am" found at position 3. 

Substitute 

To replace existing text with new text in a string, use the SUBSTITUTE function. 

 

Separate Strings  

This example teaches you how to separate strings in Excel. 

 

The problem we are dealing with is that we need to tell Excel where we want to separate the string. 

In case of Smith, Mike the comma is at position 6 while in case of Williams, Janet the comma is at 

position 9. 

1. To get the first name, use the formula below. 



 

Explanation: to find the position of the comma, use the FIND function (position 6). To get the 

length of a string, use the LEN function (11 characters). =RIGHT(A2,LEN(A2)-FIND(",",A2)-1) 

reduces to =RIGHT(A2,11-6-1). =RIGHT(A2,4) extracts the 4 rightmost characters and gives the 

desired result (Mike). 

2. To get the last name, use the following formula. 

 

Explanation: to find the position of the comma, use the FIND function (position 6). 

=LEFT(A2,FIND(",", A2)-1) reduces to =LEFT(A2,6-1). =LEFT(A2,5) extracts the 5 leftmost 

characters and gives the desired result (Smith). 

3. Select the range B2:C2 and drag it down. 



 



3. Debug a formula by using the Evaluate Formula feature 

A way to evaluate formulas in Excel is the Evaluate Formula option that resides on the Formulas 

tab, in the Formula Auditing group. 

 

As soon as you click this button, the Evaluate Formula dialog box will pop up, where you can 

inspect each part of your formula in the order the formula is calculated. 

All you need to do is click the Evaluate button and examine the value of the underlined formula 

part. The result of the most recent evaluation appears in italics. 

 

Continue clicking the Evaluate button until each part of your formula has been tested. 

To end the evaluation, click the Close button. 

To start the formula evaluation from the beginning, click Restart. 

If the underlined part of the formula is a reference to a cell containing another formula, click the 

Step In button to have that other formula displayed in the Evaluation box. To get back to the 



previous formula, click Step Out. 

 

Note. The Step In button is not available for a cell reference pointing to another formula in a different 

workbook. Also, it is not available for a cell reference that appears in the formula for the second time (like 

the second instance of D1 in the screenshot above).  

 

 



4. Text to Columns 

To separate the contents of one Excel cell into separate columns, you can use the 'Convert Text to 

Columns Wizard'. For example, when you want to separate a list of full names into last and first 

names. 

1. Select the range with full names. 

 

2. On the Data tab, in the Data Tools group, click Text to Columns. 

 

The following dialog box appears. 

3. Choose Delimited and click Next. 



 

4. Clear all the check boxes under Delimiters except for the Comma and Space check box. 

5. Click Finish. 

 



Note: This example has commas and spaces as delimiters. You may have other delimiters in your 

data. Experiment by checking and unchecking the different check boxes. You get a live preview of 

how your data will be separated. 

Result: 

 



5. Remove Unwanted Characters 

The TRIM function returns a string with extra spaces, starting spaces and ending spaces removed. 

The CLEAN function removes nonprintable characters from a string. 

1. For example, cell A1 below contains the string " Excel   Easy  " 

 

Note: the TRIM function returns the string "Excel Easy". 

2. For example, cell A1 below contains a nonprintable character. 

 

Note: the CLEAN function removes this nonprintable character. Text imported from other 

applications may contain nonprintable characters. 

 



6. Excel VLOOKUP tutorial for beginners - syntax and 

formula examples 

by Svetlana Cheusheva  

This article begins a series covering one of the most useful Excel functions - VLOOKUP. At the same time, 

it's one of the most intricate and least understood. 

In this VLOOKUP tutorial, I will try to explain the basics in a very plain language to make the learning curve 

for an inexperienced user as easy as possible. We will also explore some formula examples that address the 

most common usages of VLOOKUP in Excel. 

Excel VLOOKUP function - basic description and syntax 

So what is VLOOKUP? To begin with, it is an Excel function : ) What does it do? It searches for the value you 

specify and returns a matching value from another column. More technically, the VLOOKUP function looks 

up a value in the first column of the specified range of cells, and returns a value in the same row from 

another column. 

In its common usage, Excel VLOOKUP searches through your lists of data based on the unique identifier and 

brings you a piece of information associated with that unique identifier. 

The letter "V" in VLOOKUP stands for "vertical". It is used to differentiate VLOOKUP from the 

HLOOKUP function that looks up a value in the top row of an array (H stands for "horizontal"). 

The VLOOKUP function is available in all versions of Excel 2013, Excel 2010, Excel 2007, Excel 

2003, Excel XP and Excel 2000. 

Excel VLOOKUP syntax 

The syntax for the VLOOKUP function is as follows: 

VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

As you see, the Microsoft Excel VLOOKUP function has 4 parameters, or arguments. The first 

three parameters are requited, the last one is optional. 

1. lookup_value - the value to search for.  

This can be either a value (number, date or text) or a cell reference (reference to a cell 

containing a lookup value), or the value returned by some other Excel function. For 

example: 

o Look up for number: =VLOOKUP(40, A2:B15, 2) - the formula will search for the 

number 40. 

o Look up for text: =VLOOKUP("apples", A2:B15, 2) - the formula will search for 

the text "apples". 

o Look up for value in another cell: =VLOOKUP(C2, A2:B15, 2) - the formula will 

search for the value in cell C2. 



Note. If the lookup value is a number and it's smaller than the smallest value in the first 

column of your lookup array, the VLOOKUP function returns the #N/A error. 

2. table_array - two or more columns of data.  

Remember, the VLOOKUP function always searches for the lookup value in the first 

column of table_array. Your table_array may contain various values such as text, dates, 

numbers, or logical values. Values are case-insensitive, meaning that uppercase and 

lowercase text are treated as identical. 

So, our formula =VLOOKUP(40, A2:B15,2) will search for "40" in cells A2 to A15 because 

A is the first column of the table_array A2:B15. Hopefully, everything is clear so far : ) 

3. col_index_num - the column number in table_array from which the value in the 

corresponding row should be returned.  

The left-most column in the specified table_array is 1, the second column is 2, the third 

column is 3, and so on. 

Well, now you can read the entire formula =VLOOKUP(40, A2:B15,2). The formula 

searches for "40" in cells A2 through A15 and returns a matching value from column B 

(because B is the 2nd column in the specified table_array A2:B15). 

 

Note. If your col_index_num argument is less than 1, the VLOOKUP formula will return 

the #VALUE! error. In case it is greater than the number of columns in table_array, your 

function will return the #REF! error. 

4. range_lookup - determines whether you are looking for an exact match (FALSE) or 

approximate match (TRUE or omitted). This final parameter is optional but very important. 

Further on in this VLOOKUP tutorial, I will provide a few examples explaining how to 

correctly make formulas for exact or approximate match. 

https://www.ablebits.com/office-addins-blog/2014/07/17/excel-vlookup-tutorial-beginner/#exact-approximate-vlookup


Excel VLOOKUP examples 

I hope the VLOOKUP function is starting to look a bit more familiar to you. Now let's explore a 

few examples of using VLOOKUP formulas on real data. 

How to do vlookup in Excel from another worksheet 

In practice, VLOOKUP formulas are rarely used to find data in the same worksheet. Most often you 

will have to look up and pull the matching data from a different sheet. 

To do a vlookup from a different Excel sheet, you should enter the worksheet's name and an 

exclamation mark in the table_array argument before the range of cells, e.g. =VLOOKUP(40, 

Sheet2!A2:B15,2). The formula indicates that the lookup range A2:B15 is located in Sheet2. 

Of course, you don't have to type the sheet's name manually. Simply start typing the formula and 

when it comes to the table_array argument, switch to the lookup worksheet and select the range 

using a mouse. 

The formula you see in the screenshot below searches for the text "Product 1" in column A (the 1st 

column of the lookup range A2:B9) in the Prices worksheet: 

=VLOOKUP("Product 1",Prices!$A$2:$B$9,2,FALSE) 

 

Please pay attention that you have to enclose a lookup text value in quotes (''") as you usually do in 

Excel formulas. 

Tip. It is a good idea to always use absolute cell references (with $) in the table_array parameter 

of VLOOKUP formulas. In this case, the lookup range will remain constant when you copy the 

formula to other cells. 

How to do vlookup from a different workbook 

To perform vlookup between two different Excel workbooks, you should supply the workbook's 

name in square brackets before the worksheet's name. 

For example, the below formula will look up value "40" in Sheet2 of the Numbers.xlsx workbook: 



=VLOOKUP(40, [Numbers.xlsx]Sheet2!A2:B15,2) 

The easiest way to create an Excel VLOOKUP formula that refers to another workbook is this: 

1. Open both workbooks. This step is not obligatory, but makes it easier to write a formula 

because you won't have to type the workbook's name manually, thus preventing misprints. 

2. Start typing your VLOOKUP formula, and for the table_array argument, switch to the other 

workbook and select the lookup range there. 

In the formula you see in the screenshot below, the lookup workbook is PriceList.xlsx and the 

lookup worksheet is Prices. 

 

Once you close the workbook with your lookup table, your VLOOKUP formula will work anyway, 

but it will display the full path for the lookup workbook, as shown below: 

 

Note. If either a workbook name or worksheet name contains spaces, you should add apostrophes 

around them: =VLOOKUP(40, '[Numbers.xlsx]Sheet2'!A2:B15,2) 

How to use a named range or table in VLOOKUP formulas 

If you are supposed to use the same lookup range in several VLOOKUP formulas, you can created a 

named range for it and type the name directly in the table_array argument of your Vlookup 

formula. 

https://www.ablebits.com/office-addins-blog/2017/07/19/excel-dynamic-named-range/


To create a named range, just select the cells and type any name in the Name box, to the left of the 

Formula bar. 

 

And now you can write the following VLOOKUP formula to get Product 1's price: 

=VLOOKUP("Product 1",Products,2) 

Most range names in Excel apply to the entire workbook, so you don't need to specify the 

worksheet's name, even if your lookup range resides in a different worksheet. If it is in another 

workbook, you have to put the workbook's name before the named range, for example: 

=VLOOKUP("Product 1",PriceList.xlsx!Products,2) 

Such formulas are far more understandable, aren't they? Besides, using named ranges can be a good 

alternative to absolute cell references. Since a named range doesn't change when a formula is 

copied to other cells, you can be sure that your lookup range will always remain correct. 

If you have converted a range of cells into a fully-functional Excel table (Insert tab > Table), then 

you can select the lookup range using a mouse, and Microsoft Excel will automatically add the 

columns' names or the table name to the formula: 

 

The complete formula may look similar to this: 

=VLOOKUP("Product 1",Table46[[Product]:[Price]],2) 

https://www.ablebits.com/office-addins-blog/2016/07/19/excel-table-make-format-remove/


or even =VLOOKUP("Product 1",Table46,2). 

As well as named ranges, columns names are constant and your cell references won't change no 

matter where the VLOOKUP formula is copied within the same workbook. 

Using wildcard characters in VLOOKUP formulas 

As well as in many other formulas, you can use the following wildcard characters in the Excel 

VLOOKUP function: 

 Question mark (?) to match any single character, and 

 Asterisk (*) to match any sequence of characters. 

Using wildcard chars in your VLOOKUP formulas may prove really useful in many cases: 

 When you do not remember the exact text you are looking for. 

 When you want to find some word that is part of the cell's contents. Be aware that the 

VLOOKUP function searches by the entire content of a cell, as if you selected the option 

"Match entire cell content" in the standard Excel Find dialog. 

 When a lookup column contains extra leading or trailing spaces. If it is the case, you may 

rack your brain trying to figure out why the normal formula does not work. 

Example 1. Look up text starting or ending with certain characters 

Suppose, you want to find a certain customer in the below database. You cannot remember his 

surname, but you know it starts with "ack". So, the following VLOOKUP formula will work a treat: 

=VLOOKUP("ack*",$A$2:$C$11,1,FALSE) 

 

Once you are sure you've found the correct name, you can use a similar VLOOKUP formula to get 

the sum paid by that customer. You only have to change the 3rd parameter in the formula to the 

appropriate column number, column C (3) in our case: 

=VLOOKUP("ack*",$A$2:$C$11,3,FALSE) 



Here a few more examples of VLOOKUP formulas with wildcard characters: 

=VLOOKUP("*man",$A$2:$C$11,1,FALSE) - find the name ending with "man". 

=VLOOKUP("ad*son",$A$2:$C$11,1,FALSE) - find the name starting with "ad" and ending with 

"son". 

=VLOOKUP("?????",$A$2:$C$11,1,FALSE) - find a 5-character last name. 

Note. For a wildcard VLOOKUP formula to work correctly, you always have to add FALSE as the 

last parameter. If your lookup range contains more than one entry that meets the wildcard criteria, 

the first found value will be returned. 

Example 2. Wildcard VLOOKUP formulas based on cell's value 

And now let's discuss a bit more complex example of how to do a vlookup on the value in some 

cell. Suppose, you have license keys in column A and license names in column B. You also have 

part (a few characters) of some license key in cell C1 and you want to find a matching License 

Name. 

This can be done using a VLOOKUP formula like this: 

=VLOOKUP("*"&C1&"*",$A$2:$B$12,2,FALSE) 

This formula searches for the value in C1 through the specified range and returns a corresponding 

value in column B. Please notice that we use an ampersand (&) before and after a cell reference in 

the 1st parameter to concatenate a text string. 

As you can see in the screenshot below, my VLOOKUP function returns "Jeremy Hill" because his 

license key contains the group of chars stated in cell C1: 

 

Also, please pay attention to the table_array argument in screenshot above. It contains the table 

name ("Table7") instead of a range of cells, as we discussed in the example above. 

https://www.ablebits.com/office-addins-blog/2014/07/17/excel-vlookup-tutorial-beginner/#vlookup-named-range


Using VLOOKUP formulas with exact or approximate match 

And finally, let's have a closer look at the last argument you supply to the Excel VLOOKUP 

function - range_lookup. As already mentioned at the beginning of this tutorial, this parameter is 

highly important because you are likely to get different results in the same formula depending on 

whether you enter TRUE or FALSE. 

First off, let's see what Microsoft Excel actually means by "exact match" and "approximate match". 

 If range_lookup is set to FALSE, the formula searches for exact match, i.e. for the lookup 

value exactly as you've entered it in the first parameter (lookup_value ).  

If there are two or more values in the first column of table_array that match the lookup 

value, the 1st value found is returned. If an exact match is not found, the #N/A error is 

returned. 

For example, if you use the formula =VLOOKUP(4, A2:B15,2,FALSE), but your data does 

not contain value 4 in cells A2 through A15, the formula will return #N/A. 

 If range_lookup is set to TRUE or omitted, the formula searches for approximate match. 

More precisely, your VLOOKUP formula will search for an exact match first and if an exact 

match is not found, it will return an approximate match. An approximate match is the next 

largest value that is less than lookup_value. 

Important Note! If you enter TRUE or omit the range_lookup argument, the values in the first 

column of the lookup range must be sorted in ascending order, i.e. from smallest to largest. 

Otherwise, the Excel VLOOKUP function may not find the correct value. 

To further explore the importance of specifying TRUE vs. FALSE, let's try out a few more 

VLOOKUP formulas and see what results they return. 

Example 1. How to do a vlookup in Excel with exact match 

As you remember, to search for exact match, you have to put FALSE as the final argument in a 

VLOOKUP formula in Excel. 

Let's take the 'Animal speed' table from the very first example again and find out which animal can 

run 50 miles per hour. I believe you won't have any difficulties with the formula: 



=VLOOKUP(50,$A$2:$B$15,2,FALSE). 

 

Please note, our lookup range (column A) contains two "50" values in cells A5 and A6; and the 

formula returns a value from cell B5. Why is that? Because the VLOOKUP function with exact 

match returns the 1st found value that matches the lookup value. 

Example 2. Using vlookup in Excel with approximate match 

When using VLOOKUP formulas with approximate match, i.e. with range_lookup set to TRUE or 

omitted, the first thing you need to do is sort the first column in your lookup range in ascending 

order. 

This is very important because your VLOOKUP formula is going to return the next largest value for 

the lookup value you specify and then stop searching. If you neglect to sort your data properly, you 



will end up having really strange results or the #N/A error. 

 

And now you can utilize either of the following formulas: 

 =VLOOKUP(69,$A$2:$B$15,2,TRUE) 
 =VLOOKUP(69,$A$2:$B$15,2) 

As you see, I am trying to find the animal whose speed is closest to 69 mph. And here's what the 

VLOOKUP formula returns: 

 

As you see, the formula returns "Antelope" whose speed is 61mph, while we also have Cheetah that 

runs 70 mile per hour, and 70 is much closer to 69 than 61, isn't it? So, why is that? Because the 

VLOOKUP function with approximate match returns the next largest value that is less than the 

lookup value. 



Hopefully, these examples have shed some light on using VLOOKUP in Excel and this function is 

not alien to you any longer : ) Now it may be a good idea to sum up the essentials you have learned 

to remember the key points better. 

Excel VLOOKUP - things to remember! 

1. Excel VLOOKUP function cannot look at its left. It always searches for the lookup value in 

the left-most column of the lookup range (table_array). 

2. In VLOOKUP formulas, all values are case-insensitive, meaning that uppercase and 

lowercase characters are treated as equivalent. 

3. If the lookup value is smaller than the smallest value in the first column of your lookup 

range, the VLOOKUP function returns the #N/A error. 

4. If the 3rd parameter (col_index_num) is less than 1, the VLOOKUP formula will return the 

#VALUE! error. In case it is greater than the number of columns in your lookup range 

(table_array), the formula will return the #REF! error. 

5. Use absolute cell references in the table_array argument of your VLOOKUP formulas to 

have the correct lookup range when coping the formulas. Consider using named ranges or 

Excel tables as an alternative. 

6. When searching with approximate match (range_lookup set to TRUE or omitted), always 

have the data in the first column in your lookup range sorted in ascending order. 

7. And finally, remember about the importance of the final parameter. Supply TRUE or 

FALSE when appropriate and you will avoid a lot of headache : ) 

In the next part of our Excel VLOOKUP tutorial we will explore more advanced examples such as 

performing various calculations with VLOOKUP, extracting values from several columns and 

more. I thank you for reading and hope to see you next week! 



7. Pivot Tables 

Pivot tables are one of Excel's most powerful features. A pivot table allows you to extract the significance 

from a large, detailed data set. 

Our data set consists of 213 records and 6 fields. Order ID, Product, Category, Amount, Date and Country. 

 

Insert a Pivot Table 

To insert a pivot table, execute the following steps. 

1. Click any single cell inside the data set. 

2. On the Insert tab, in the Tables group, click PivotTable. 

 

The following dialog box appears. Excel automatically selects the data for you. The default location 

for a new pivot table is New Worksheet. 

3. Click OK. 



 

Drag fields 

The PivotTable Fields pane appears. To get the total amount exported of each product, drag the 

following fields to the different areas. 

1. Product field to the Rows area. 

2. Amount field to the Values area. 

3. Country field to the Filters area. 



 

Below you can find the pivot table. Bananas are our main export product. That's how easy pivot 

tables can be! 

 

Sort 

To get Banana at the top of the list, sort the pivot table. 

1. Click any cell inside the Sum of Amount column. 



2. Right click and click on Sort, Sort Largest to Smallest. 

 

Result. 

 

Filter 

Because we added the Country field to the Filters area, we can filter this pivot table by Country. For 

example, which products do we export the most to France? 

1. Click the filter drop-down and select France. 

Result. Apples are our main export product to France. 



 

Note: you can use the standard filter (triangle next to Row Labels) to only show the amounts of 

specific products. 

Change Summary Calculation 

By default, Excel summarizes your data by either summing or counting the items. To change the 

type of calculation that you want to use, execute the following steps. 

1. Click any cell inside the Sum of Amount column. 

2. Right click and click on Value Field Settings. 

 

3. Choose the type of calculation you want to use. For example, click Count. 



 

4. Click OK. 

Result. 16 out of the 28 orders to France were 'Apple' orders. 

 

Two-dimensional Pivot Table 

If you drag a field to the Rows area and Columns area, you can create a two-dimensional pivot 

table. First, insert a pivot table. Next, to get the total amount exported to each country, of each 

product, drag the following fields to the different areas. 

1. Country field to the Rows area. 

2. Product field to the Columns area. 

3. Amount field to the Values area. 

4. Category field to the Filters area. 



 

Below you can find the two-dimensional pivot table. 

 

To easily compare these numbers, create a pivot chart and apply a filter. Maybe this is one step too 

far for you at this stage, but it shows you one of the many other powerful pivot table features Excel 

has to offer. 



 

 



8. Find Quick Answers With Excel Goal Seek 

Last Updated on 30-Mar-2017 by AnneH 

The days after elections people often ask “what-if” questions. Some races are close and the vote 

count goes on for days. In other cases, people want to know how many votes would’ve been needed 

to win. Excel Goal Seek is good tool for answering these and other forecasting questions. 

What is Goal Seek? 

Goal Seek is a built-in Excel tool that allows you to see how one data item in a formula impacts 

another. You might look at these as “cause and effect” scenarios. For example, you might be 

looking at your local election results and see: 

 
Votes % of Votes 

YES 4478 63.90 * 

NO 2530 36.10 

Total 7008 100 

* Needs approval from 2/3 of the voters 

In our example, the YES votes are a majority, but shy of the required 2/3 approval to win the 

election. People quickly realize they were close, but which item do they change to find out how 

close. What would’ve made a difference? 

Using Goal Seek we can change the value of various cells to see how the results change. This would 

allow you to answer these types of questions. 

 How many “NO” voters needed to be converted to YES to win the election?  
 How many more votes were needed by the YES team to win the election?  
 If 500 more people voted could the YES team have won? 

In each of these questions, the goal is to change a data value to see if the YES percentage went over 

that two-thirds mark or 66.67%. Rather than haphazardly changing cell values to see the results, 

Goal Seek can find the answers. 

How to Use Excel Goal Seek 

1. Create a spreadsheet in Excel that has your data. 

https://www.timeatlas.com/author/anneh/


 

2. Click the cell you want to change. This is called the “Set cell”. In my example, this will be D4. 
3. From the Data tab, select the What if Analysis…button 
4. Select Goal seek.. from the drop down menu 
5. In the Goal Seek dialog, enter the new “what if” amount in the To value text box. (Remember to 

add the percentage sign if you have one.) 

 

In this example, we’re asking Excel to replace the contents of cell D4 which is 63.90% with 

66.67%. This is the percentage needed to win the election. 

6. We also need to tell Excel which cell to change. Since we wanted to know the number of YES votes, 
we’ll click C4. 

https://www.timeatlas.com/wp-content/uploads/goals1.png
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7. Click OK. Excel will overwrite the previous cell value with the new one. 

 

8. If you wish to accept the new value, click OK. 

Goal Seek Requirements & Gotchas 

https://www.timeatlas.com/wp-content/uploads/goals3-1.jpg
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I can hear some readers yelling “wait…. don’t accept the value”. Actually, people may be yelling 

for two reasons. 

If you look closely in the Goal Seek Status box, you’ll see the Target value: reads: 0.6667 came 

from our 66.67%. But the Current value: shows as 66.64%. Excel rounded down and the revised 

YES value wouldn’t win the election since 66.64% is less than 66.67%. 

Another group may be asking why Excel didn’t just take 66.67% of the TOTAL vote count 7008. 

And that leads us to a requirement of Goal Seek – formulas. The Set cell in Step 2 must contain a 

formula. In our example, the initial 63.90% was a formula using the YES value (C4) divided by 

TOTAL value (C6). So, we met that requirement. 

 

If I just typed the value 63.90% and tried to use Goal Seek, I would see an Excel error stating “Cell 

must contain a formula”. 

Just as I used a formula in my set cell, I also used a formula for TOTAL in B6. This was the Sum of 

my YES and NO votes. Since this TOTAL cell was a formula, my TOTAL count automatically 

adjusted when Goal Seek changed the YES cell value. If I typed “7008” in cell C6, only the YES 

cell value would have changed. 

The other requirement is the cell you change in Step 6 can’t contain a formula. It must be a typed 

value. 

As this example shows, Goal Seek is a nice tool that can quickly find the answers to different 

situations. Although this was a simple example, you can use the same tool for complicated 

spreadsheets containing many variables and formulas. Just remember, you many not always like the 

results. 

https://www.timeatlas.com/wp-content/uploads/goals5.png


9. Paired Sample t Test 

Charles Zaiontz 

Motivations 

In paired sample hypothesis testing, a sample from the population is chosen and two measurements 

for each element in the sample are taken. Each set of measurements is considered a sample. Unlike 

the hypothesis testing studied so far, the two samples are not independent of one another. Paired 

samples are also called matched samples or repeated measures. 

For example, if you want to determine whether drinking a glass of wine or drinking a glass of beer 

has the same or different impact on memory, one approach is to take a sample of say 40 people, and 

have half of them drink a glass of wine and the other half drink a glass of beer, and then give each of 

the 40 people a memory test and compare results. This is the approach with independent samples. 

Another approach is to take a sample of 20 people and have each person drink a glass of wine and 

take a memory test, and then have the same people drink a glass of beer and again take a memory 

test; finally we compare the results. This is the approach used with paired samples. 

The advantage of this second approach is the sample can be smaller. Also since the sampled subjects 

are the same for beer and wine there is less chance that some external factor (confounding variable) 

will influence the result. The problem with this approach is that it is possible that the results of the 

second memory test will be lower simply because the person has imbibed more alcohol. This can be 

corrected by sufficiently separating the tests, e.g. by conducting the test with beer a day after the test 

with wine. 

It is also possible that the order in which people take the tests influences the result (e.g. the subjects 

learn something on the first test that helps them on the second test, or perhaps taking the test the 

second time introduces a degree of boredom that lowers the score). One way to address these order 

effects is to have half the people drink wine on day 1 and beer on day 2, while for the other half the 

order is reversed (called counterbalancing). 

The following table summarizes the advantages of paired samples versus independent samples: 

Paired Samples Independent Samples 

Need fewer participants Fewer problems with fatigue or practice 

effects 

Greater control over confounding variables Participants are less likely to figure out the 

purpose of the study 

Figure 1 – Comparison of independent and paired samples 

Obviously not all experiments can use the paired sample design. E.g. if you are testing differences 

between men and women, then independent samples will be necessary. 

How to perform paired t-test with Data analysis tool excel 



Excel  provides  a  data  analysis  tool  that  takes  care  of  just  about  everything  for matched samples. It’s 

called t-test: Paired Two Sample for Means. In this section, I use it on the weight-loss data. 

Null hypothesis: there is not loss of weight  

Activate the data analysis tool 

f you need to develop complex statistical or engineering analyses, you can save steps and time by using the 

Analysis ToolPak. You provide the data and parameters for each analysis, and the tool uses the appropriate 

statistical or engineering macro functions to calculate and display the results in an output table. Some tools 

generate charts in addition to output tables. 

The data analysis functions can be used on only one worksheet at a time. When you perform data 

analysis on grouped worksheets, results will appear on the first worksheet and empty formatted 

tables will appear on the remaining worksheets. To perform data analysis on the remainder of the 

worksheets, recalculate the analysis tool for each worksheet. 

1. Click the File tab, click Options, and then click the Add-Ins category. 

2. In the Manage box, select Excel Add-ins and then click Go. 

If you're using Excel for Mac, in the file menu go to Tools > Excel Add-ins. 

3. In the Add-Ins box, check the Analysis ToolPak check box, and then click OK. 

o If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to 

locate it. 

o If you are prompted that the Analysis ToolPak is not currently installed on your 

computer, click Yes to install it. 

How to perform the t-test 

Here are the steps to follow: 

1. Enter the data for each sample into a separate data array. 
For this example, the data in the Before sample are in column B and the data for the After sample are in 
column C. 

2. Select Data | Data Analysis to open the Data Analysis dialog box. 

3. In the Data Analysis dialog box, scroll down the Analysis Tools list, and select t-Test: Paired Two Sample 
for Means. 



4. 4.  Click OK to open this tool’s dialog box. 
This is the dialog box

 

5. In the Variable 1 Range box, enter the cell range that holds the data for one of the samples. 
For the example, the Before data are in $B$2:$B$12, including the heading.  
(Note the $ signs for absolute referencing.) 

6. In the Variable 2 Range box, enter the cell range that holds the data for the other sample. 
The After data are in $C$2:$C$12, including the heading. 

7. In the Hypothesized Mean Difference box, type the difference between μ1 and μ2  that H0 specifies. 
In this example, that difference is 0. 

8. If the cell ranges include column headings, select the Labels check box. 
I included the headings in the ranges, so I selected the check box. 

9. The Alpha box has 0.05 as a default. Change that value if you want to use a different α. 

10.  In the Output Options, select a radio button to indicate where you want the results. I selected New 
Worksheet Ply to put the results on a new page in the work sheet. 

11. Click OK. 

Because I selected New Worksheet Ply, a newly created page opens with the results. 

 



 

Pearson Correlation Coefficient 

The only item that’s new is the number in cell B7, the Pearson Correlation Coefficient. This is a number 

between –1 and +1 that indicates the strength of the relationship between the data in the first sample and 

the data in the second. If the number is close to –1, high scores in the first sample are associated with low 

scores in the second, and low scores in the first are associated with high scores in the second. If the number 

is close to zero, scores in the first sample are unrelated to scores in  the second. Because the two samples 

consist of scores on the same people, you expect a high value.  

Cell B8 shows the H0-specified difference between the population means, and B9 shows the degrees of 

freedom.  

The remaining rows provide  t-related  information.  The calculated  value  of  the test statistic is in B10. Cell 

B11 gives the proportion of area the positive value of the test statistic cuts off in the upper tail of the t-

distribution with the indicated df (gdl in italiano).  

Cell B12 gives the critical value for a one-tailed test: That’s the value that cuts off  the proportion of the 

area in the upper tail equal to α. 

Cell B13 doubles the proportion in B11. This cell holds the proportion of area from B11 added to the 

proportion of area that the negative value of the test statistic cuts off in the lower tail. Cell B13 shows the 

critical value for a two-tailed test: That’s the positive value that cuts off α/2 in the upper tail. The 

corresponding negative value (not shown) cuts off α/2 in the lower tail. 

 

 

 

In brief: 



If p > alpha, we reject the H0 

If p < alpha we cannot reject H= 

 

 

 


